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Chapter

1

Welcome to DIWE

In This
Guide

Welcome to the Daedalus® Integrated Writing Environment (also known as
DIWE) from the Daedalus Group, Inc. DIWE is designed for writing instruction,
collaboration, and communication among students and teachers in all curricula.
This Instructor's Guide provides you with theoretical and practical pedagogical
support for using the Daedalus Integrated Writing Environment.

This guide explains how to install, set up, and manage DIWE at a site. The in-
stallation details in this guide repeat the information in the Installation Guide
which is distributed with Installation diskettes.

What is DIWE?" overviews the components which comprise DIWE and the
ways DIWE affects the teacher and student in the computer-based class-
room.

Program Documentation” outlines the print and online help files which are
available with the software.

Installing DIWE" explains how to install the software on individual worksta-
tions and your network server. This section also includes details on how to
determine which resources you need to install at your site and explains the
possible network configurations you can choose for your site.

Setting Network Permissions”outlines how to set folder and file permissions
for your workstations and server, and includes details on other security issues.

Printing Program Documentation” explains how to print and distribute the
three guides which accompany the program.

Setting Up Your Site provides instructions for setting up new classes, choos-
ing preferences for your site, managing your site by modifying classes and in-
formation on teachers and students, and setting up a new semester.

Understanding File Structure describes the files and folders used by the
program.

* These sections duplicate information available in the Installation Guide which is shipped in printed
form with DIWE's Installation diskettes.
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Customizing Your Copy of DIWE explains how to optimize the program for
your site, to set preferences, and to customize the tools.

Troubleshooting includes details on the error messages which can appear in
the program and provides step-by-step instructions on resolving questions
and improving the software's performance.

Getting Help outlines the additional resources available to teachers and
technicians working with DIWE, including details on how to contact the
Daedalus Group for answers to your questions about the software.

Finding Other Program Information

If you need to know more about how to use any of the tools in DIWE, please
consult the User's Guide.

If you need instructions on managing Class Assignments, Mail and InterChange
conferences, and turned in documents, see the Instructor's Guide.

Conventions used in this document

Couri er font indicates text that is displayed or typed on the screen

Boldface sighals menu commands and button commands.

Italic font represents information that you will have to provide. If asked to
type yourfilename, you might type PAPERL

<Key> refers to an actual control key on your keyboard.

<Keyl+Key2> indicates that two keys should be pressed together. For in-
stance, when instructed to press <Alt+F9>, you would press (and hold)
the <Alt> key and press the <F9> key.

Although the software is referred to by its full name (the Daedalus Integrated
Writing Environment) most of the time, it is often shortened to DIWE to keep
things simple.
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Chapter

2

What Is DIWE?

DIWE, the Daedalus Integrated Writing Environment, is award-winning computer
software, developed by writing teachers for writing teachers and used by students
in hundreds of schools, ranging from middle school to four-year universities.

Writing and Thinking Tools

DIWE is an integrated package of writing / thinking tools designed with the class-
room in mind. The program focuses on teaching and learning by means of
(often interactive) written discourse — encouraging collaborative work, critical
thinking skills, and communication. DIWE is comprised of these six modules,
each designed to address a specific task or stage of producing a piece of writing:

DIWE 1.4

Invent stimulates writers to explore their topics and to
think divergently. The tool allows writers to save and print
out the text to help them generate first drafts. Teachers
can compose their own Invent questions to supplement
the twelve standard sets which come with the software.

Write is a streamlined word processor which allows
teachers to teach writing, not word-processing. It includes
all basic operations (copying, pasting, spell-checking,
printing) for writers to produce and revise drafts.

Respond allows writers to call up drafts and other
documents for on-line analysis and review. Writers can
save and print their text to use as they work on other as-
signments. Prompts can be modified to suit the assign-
ment, ranging from peer review to document analysis.

Mail acts as the central switchboard for class communi-
cations, from private mail to group work. Date, time, and
receipt stamps make it an effective class management
tool.
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BiblioCite®

InterChange enables synchronous, or "real-time"
discussions for whole classes or small groups. Transcripts
of these discussions are recorded and are available for
viewing and printing.

BiblioCite prompts writers to record bibliographic en-
tries and maintains them in a database of sources. It
generates a Works Cited page in MLA style or a Refer-
ences Page in APA style.

Class and Document Management Tools

In addition to the six modules, DIWE includes class and document management
tools which streamline the process of sharing documents and distributing hand-
outs as well as allow the teacher to customize the content to fit the class.

=,
|
- \|
k "
Class
Assignment

Document
Management

i Login }

Login

PromptManager

DIWE 1.4

Class Assignment allows teachers to post instruc-
tions and other messages to their students in a file they
can view at any time but which only the teacher can modify
or delete. The document is the first thing students see
when they log into the class, and it can be modified as
often as the teacher wants.

Document Management organizes the system
for sharing documents in the class. Students can turn in
drafts for peer review or collaboration and read the papers
and drafts of others in their class using the Turn In a
Document, the View a Document, and the Copy a Docu-
ment commands.

Logln is student-based, allowing each student to log in
without complex administrative set-up. With this login, the
student becomes a registered participant in all modules %
from Mail to InterChange to Document Management, all
work the student does is linked to a specific login name.

PromptManager is a SuperCard stack teachers
can use to create an Invent or Respond prompt series or
to customize an existing series. Teachers can run the pro-
gram within DIWE or they can copy the files to a diskette
and work outside the DIWE classroom % on their office or
home computer.
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Local Area Network Tools

All the sharing and collaborating in DIWE takes place on a network, connecting
all the students in a particular class or lab at your site.

Local Area Networking allows users to share
their files and documents. DIWE requires a Local Area
Network set-up, with a fileserver and workstations. Even if
. you set up your site using a peer-to-peer network, one of
Local Area your machines will need to function as the fileserver by
Networking serving as the location for the network files for the software
(including files such as the questions for Invent and Re-
spond and the shared files for Mail and InterChange ses-
sions).
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Chapter

3

Program Documentation

DIWE's program documentation includes three printable guides and three on-line
documentation files. Only the Installation Guide is printed and distributed with
software diskettes. The remaining guides can be printed using Microsoft Word
6.0, 7.0, Word 97, Microsoft Office or any other word processor which supports
Rich Text Format (RTF).

Teachers and students at your site will need access to these files. The basic
guestions which teachers and students need to use DIWE are answered in these
guides. By providing copies of the files where teachers and students can reach
them, you'll enable users at your site to answer many of their own questions.
Details on providing additional access to the online help files is included in this
section. Complete details on setting up and printing these files are available in
the Printing Program Documentation section of this guide.

User's, Instructor's, and Administrator's Guides

DIWE's print documentation includes three guides: a User's Guide which de-
scribes the tools and commands in the program, an Instructor's Guide which ex-
plains how teachers can use the tools in the program, and the text you're reading
now, the Administrator's Guide which explains more about setting up and man-
aging your site. All three of these guides are copied to your server when you in-
stall the software and can be downloaded from

htt p: // ww. daedal us. com t ech/ docs. ht nl

On-Line Help System

DIWE'’s on-line help system answers questions about how to use the tools in the
program, how teachers can use the program to reach their pedagogical goals,
and what you, as the administrator, will need to do to manage the system.

There are two primary on-line help files which come with the program: User Help
and Instructor Help. The Program Help file explains how the tools in DIWE work.
Choose User Help to find information such as how to send a message in Mail,
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where InterChange transcripts are stored, and how to save a document so that
you can open it with another word processor.

The Instructor Help file explains commands available to the teacher and the ad-
ministrator and includes teaching strategies and resources for teaching with
DIWE. Use Instructor Help to find information such as how to make an Inter-
Change transcript and what strategies are effective for managing discussion.

A third help file, Character Help, provides basic details on using non-English
characters and special symbols in DIWE (e.g., how to type the letter c with a ce-
dilla — ¢ — in InterChange).

To access these help files once you've logged into the program:
Choose the User Help command from the Activity pull-down menu.

Choose the Instructor Help command from the Activity pull-down menu to
access the Instructor Help file.

Choose Character Help command from the Activity menu to access the
Character Help file.

Printing Specific Topics from the On-Line Help Files

All the topics in the on-line help can be printed. This capability comes in handy
when you need a handout which tells teachers or students how to complete a
task in DIWE.

To print a topic in either Help file, navigate to the topic you want to print, and
choose the Print Topic... command under the File menu.

Running On-Line Help Files Outside DIWE

DIWE's On-Line Help files use the E-Help application. These on-line help files will
run on any Macintosh computer which is running System 7.0 or higher. To launch
one of the on-line help files outside DIWE:

1. Use the Finder to navigate to the Daedal us Folder at your site — there
should be a copy of this folder on every workstation in your classroom.

2. Within the Daedal us Folder, open the Hel p Folder.
3. Within the Hel p Folder, you'll find User Hel p and | nstruct or Hel p.
4. Double-click on the file which you want to read, and the file should open.

5. If the file does not launch, drag the file you want to open to the E-Help Appli-
cation, also in the Hel p Folder. When the E-Help Application's icon is high-
lighted, release the mouse button and the Help file should launch.

Copying DIWE's On-Line Help Files
Additionally, you can copy these files to a floppy diskette or to another machine

to explore them when you are not in the Daedalus classroom — copy all the files
in the Hel p Folder to set up a copy of the help files outside your classroom.
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Making copies of the help files available for teachers outside the classroom can
be helpful for those teachers who want to learn more about the program but
have limited access to the server or classroom.

NOTE: Licensing for DIWE's On-Line Help Files

Teachers using DIWE can make a copy of these on-line help files for educa-
tional use on an office or home computer without violating the licensing agree-
ment.

Accessing Other Resources

Additional technical and pedagogical information is available from the Daedalus
Group WWW pages at http://ww. daedal us.coni and by e-mail to
hel p@laedal us. com
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Installation and Setup

Chapter 4 Installing DIWE

Chapter 5 Setting Network Permissions
Chapter 6 Printing & Distributing Documentation
Chapter 7 Setting Up Your Site

Chapter 8 Understanding DIWE's File Structure
Chapter 9 Customizing DIWE for Your Site

Chapters 4 through 9 provide details on process the administrator should follow
to install DIWE at a site, to set-up instructors and classes, and to set preferences
and other settings.

If you have already installed the software, following the instructions in the small,
printed Installation Guide which is distributed with the program diskettes, you're
ready to move directly to Chapters 7 through 9.

If you're installing the software, using the instructions in this Administrator's
Guide, begin with Chapter 4 and work through the Guide to Chapter 6 to install
DIWE at your school; then, move to Chapters 7 through 9 to set-up and custom-
ize your site.
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Chapter

A

Installing DIWE

The Daedalus Integrated Writing Environment (DIWE) is designed for use on a
local area network (LAN) running a network operating system such as Ap-
pleshare, Windows NT, or Novell. Installation on the hard drive of the network
fileserver proves quite easy. This manual assumes you have a working knowl-
edge of your network operating software, but if you do not, you'll need to consult
the manuals and guides for your network operating system to learn the exact
steps you'll follow to set up your network permissions and access properly.

DIWE takes care of much of the maintenance of files, folders, and access rights;
you will, however, need to make some adjustments using the Administration utili-
ties of Appleshare before students may use the software. As with any software,
you should make backup copies of your DIWE diskettes before installation.

DIWE and all its related files are compressed into an archive, segmented onto
three diskettes. There are six basic steps to installing for your site:

Confirming system requirements for your site (see page 13)
Deciding on system setup (see page 15)

Decompressing the software (see page 16)

Checking file structure (see page 17)

Setting up your fileserver (see page 20)

Setting up your workstations (see page 21)

- Confirming System Requirements
ep

One To use the Daedalus Integrated Writing Environment, your site needs equipment
which meets the following minimum specifications. Using computers or software
which do not meet these minimum specifications could result in unsatisfactory
performance.
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Minimum 68030 CPU running at 25MHz or higher: (for example, LCIII, llci, Per-
forma 450 and above, Quadra 605 and above.) with the following:

Running System 7.1 or higher
Color or grayscale monitor

4 MB of Free RAM available for the application (beyond other system and
software requirements) At least 24 MB for the workstation is recom-
mended.

5 MB free on hard disk (DIWE version 1.4 MUST be run from the worksta-
tion hard disk. Additional space will be needed if your site purchases any
additional program resources.)

Network hardware and connections

NOTE: Network Hardware Requirements

DIWE will run on machines connected via LocalTalk (or PhoneNet), To-
ken Ring, or Ethernet. As with other network applications, faster is usu-
ally better. Since DIWE can make heavy use of the network fileserver's
hard disk, any bottleneck you encounter is more likely to be due to disk
speed than network connections. If you must choose between Eth-
ernet cards for every machine, or a very fast server and matching hard
disk, you should choose the latter (at least where DIWE is concerned).

Network Server Computer.

Minimum 68040 CPU running at 66MHz or higher: (for example, Quadra, Power
PC) with the following:

16 MB of RAM
2 MB of free hard disk space per user per semester [or 4 MB per year]

Network hardware and connections

Network-operating systems

For 10 or more users to be connected at one time, any of the following:
Appleshare 3.0 or higher
Novell Netware 3.0 or higher
Windows NT 3.5 or higher network operating system

For fewer than 10 users to be connected at one time:

Personal File Sharing using System 7 or higher. Peer-to-peer networks
may support 10 or more users, but speed and performance may be ad-
versely affected. Each network system has its own individual characteris-
tics which may limit performance as the number of users connected and
the amount of network activity increases.
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Step
Two

Deciding on System Setup

Before you install DIWE to your workstations and fileserver, you need to make
some basic decisions and take some precautions to insure that the process of
setting up your workstations and fileserver goes smoothly. Consider the following
guestions:

1.

Who Do You Need to Coordinate With At Your Site? If you're in charge of
the machines you'll be installing DIWE on, you may not need to coordinate
the installation with anyone. If not, it's always best to check with the technical
support staff at your school before changing anything on the network or in-

stalling new software.

Since DIWE requires a network operating system, you may need to
coordinate with a network administrator to get permissions for the
program's directories and files set properly. Further, a member of the
network or technical support staff at your school may have helpful ad-
vice about setting up your classroom for the best possible network
speed and performance.

Also, if you're installing the files in a computer classroom, be sure to
coordinate the installation with the teachers who will be using the
classroom — so that classes are not interrupted and so that they will
be aware that you are making changes on the machines and server
they use.

Exactly Where Will You Put DIWE's Files? Determine the hard drive where
you want to install the software. Check to ensure that the drive has enough
room for the network files and that you've chosen a drive which all the ma-
chines in your classroom have access to. DIWE 1.4 must be copied to the
individual workstations at your site (this is a change from previous Macintosh
versions of the software).

Do You Have Any Other Copies of DIWE On Your Server or Workstations?
You need to check the folder names for any other copies of DIWE on your
machines to ensure that none of your existing files are overwritten.

If you also have a copy of DOS DIWE

If you have copies of DOS DIWE on your server or worksta-
tions, check the names of the directories and the executable
files to ensure that they will not conflict with the folder names
for the Macintosh version of the program (DI VE 1.4 Net,
Daedal us Fol der, and Docunentation). You should
not have any conflicts if you have copies of both the DOS and
the Macintosh versions on your server and workstations as
long as the names are different. The default directory name
for Mac DIWE will not conflict with the default for DOS DIWE,
and since Macintosh DIWE uses long filenames — and the
DOS version of DIWE use standard eight letter filenames with
three letter extensions, it's unlikely you will have any conflicts
on your machines.
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Step
Three

Stand-Alone
Installation Note

If you also have a copy of WINDOWS DIWE

If you have copies of Windows DIWE on your server or work-
stations, check the names of the directories and the executa-
ble files to ensure that they will not conflict with the folder
names for the Macintosh version of the program (DI VEE 1. 4
Net, Daedalus Folder, and Docunentation). You
should not have any conflicts if you have copies of both the
Windows and the Macintosh versions on your server and
workstations as long as the names are different. The default
directory name for Macintosh DIWE will not conflict with the
default for Windows DIWE, and since the Mac version uses
long filenames — and the Windows version of DIWE uses
standard eight letter filenames with three letter extensions, it's
unlikely you will have any conflicts on your machines.

If you already have a copy of MACINTOSH DIWE

If you have a previous copy of MACINTOSH DIWE on your
server or workstations, check the names of the folders and
the files to ensure that they will not conflict with the folder
names for the new Macintosh version of the program ( DI \E
1.4 Net, Daedal us Fol der, and Docunentation). If
you're using the default names for your existing copy of Mac
DIWE, you should not have any conflicts since the default
names for the previous version of Macintosh DIWE will not
conflict with the defaults for this new version. If your existing
folders will conflict, however, simply change the folders so that
none of your files will be overwritten.

Decompressing the Software

These instructions explain how to install the program's local area network files
and program files to your fileserver for new software installations. Details on cus-
tom installations, including installing to your workstations and upgrading older
copies of DIWE are in the "Setting Up Your Workstations" section on page 21
and in the "Installing Custom Packages" section on page 23.

When you finish you will have installed a copy of the Daedal us Folder, which
contains the program files, a copy of the Docunent at i on Folder, which contains
the program documentation guides, and a copy of the DI WE 1.4 NET Folder
directory, which contains the local area network files.

NOTE: Stand-Alone Installation

Follow these instructions when you install the program to a single-
machine in order to run the program in a Stand-Alone configuration.
Even though you are not working on a network, you will need to install
all three folders (Daedal us, Docunent ati on, and DIVE 1.4 NET) to
run the program. When you choose locations for these files, you will
choose a location on the stand-alone machine (rather than navigating
to your network fileserver in Steps 8 and 9).
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Step
Four

From a workstation, connect to the network fileserver with full permissions.
Alternately, you can work at your network fileserver itself, logging on with full
permissions. (If you're installing the program as a stand-alone system for
testing, skip this step).

Make sure that you have full read/write/create/delete rights to the drives on
which you are installing the software. (See the "Setting Network Permissions"
section for information on the specific permissions required for your network.
Check with your network administrator if you're unsure how to set network
permissions.)

Insert Daedalus Disk 1 in your machine's floppy drive.

Double-click on the Set up file to begin the installation process. Its icon should

look like the following:

W
Setup

The installer will display a splash screen indicating the program's name and
some copyright information. Click the Continue button.

The installer next shows a read-me file which explains how to choose installa-
tion locations for your machine. After you've read this information, click the
Continue button.

In the next window, you will choose installation options. The pop-up menu in
the upper left corner of the screen should read Easy Install. This option de-
compresses all the files to a single folder on your hard drive.

In the lower middle of the Setup Dialog, use the Switch Disk button to select
the hard drive on your network fileserver where the installer will install the pro-
gram files.

(Optional) Choose the Select Folder option from the drop-down menu to
choose a specific location on the drive you've chosen. If you accept the In-
staller's default, the files will be copied, in their own folder, directly to your
hard drive.

10. Click the Install button in the lower right corner to install the files. Choose the

11.

Quit button if you want to exit the installer without changing your hard drive.
The installer will decompress the files automatically.

Insert additional diskettes as prompted, and follow the on-screen instructions
to complete your installation.

Checking File Structure

Before you copy the software and other files to the correct locations on your file-
server and workstations, check the files and folders which have been installed on
your machines to make sure that all the program files are in place. Use the
Macintosh Finder to navigate through these directories.
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Check the folders for the files and subfolders listed. Immediately after you install,
you should see only the files and subfolders listed. If you check the file structure
after you've begun using DIWE at your site, you'll see additional files as noted.

If you find that files are missing when you check the structure, the best solution
would be to delete the incomplete copy of DIWE 1.4 and reinstall. If classes are
already using the software, however, reinstalling probably isn't an option. In-
stead, you should copy any missing files from your most recent backup.

Checking the Daedalus Folder

The Daedalus folder contains the files which need to be placed on each worksta-
tion at your site. This directory contains the DIWE program, supporting help files,
and supporting dictionary files.

In the Daedalus Folder, you should find the following subdirectories and files:

| =7 Daedalus folder which contains two folders and two files:

BiblioCite Sample A sample BiblioCite database
]El DIWE 1.4 Application The program itself
—7 Help Folder Which contains the files 9 items:
Character Help File Help with accents
Character Help Media
E-Help Engine 4.0 The Help Program
Help for E-Help File Help with the Help
Help for E-Help Media Program
Instructor Help File Help for teachers and
Instructor Help Media the administrator
User Help File Help with the program
User Help Media modules
/7 Handbooks Folder Folders which may be
I~ Extras Folder present if your site pur-
chases additional program
resources
Installer Log File A system file which keeps details

on the software you've installed

=7 Proximity Folder Which contains the several files

used for spellchecking, the dic-
tionary, and the thesaurus
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Checking the DIWE 1.4 Net Folder

The DIWE 1.4 Net folder contains the files which need to be placed on your net-
work fileserver. This directory contains the network files which are used for login
and the directories where the messages and documents for each class are
stored. Only one copy of these files should exist at your site. Duplicate copies of
these files can cause the program to fail.

In the DIWE 1.4 Net Folder, you should find the following subdirectories and files.
As the program is used at your site, additional subdirectories and files will be
added; however, those listed are the minimal files and subdirectories needed to
run the program. In other words, you may find more files and subdirectories than
those listed here, but if you find fewer, something may be wrong.

=7 DIWE 1.4 Net folder which contains three files:

[~/ Clean Copies Folder Which contains fresh copies of the
Files in the Instructors folder
Daedalus Write An installer file for the stand-
Installer alone version of Write
" Instructors Folder Which contains the folders and

files necessary for file sharing and
network communication

[~ Question Series Folder Which contains prompts used in
Invent and Respond

Daedalus Preferences File The network preferences file
PromptManager A SuperCard application used
Application to customize prompts

Checking the Documentation Folder

The Documentation folder contains copies of the program documentation. You
can place these files on your fileserver or on your workstations (or in another loca-
tion which is convenient to those at your site who need access to the files).

In the Documentation Folder, you should find the following subdirectories and
files:

=7 Documentation folder which contains three files:

Users.RTF The User's Guide
Instruct.RTF The Instructor's Guide
Admin.RTF The Administrator's Guide
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Step
Five

Stand-Alone
Installation Note

Setting Up Your Fileserver

Setting up your fileserver involves making sure you have a copy of the DIWE 1.4
Net folder on the server and removing any items you do not want students at
your site to access in the DIWE folder. Follow the appropriate instructions below,
based on the way you have installed the software.

NOTE: Stand-Alone Installation
Once you've decompressed the files on your stand-alone workstation
and checked the file structure to ensure that all the files and folders are
present, you can proceed to "Setting Network Permissions" chapter of
this guide.

If You Decompressed the Program Files to Your Fileserver

Ideally, you have decompressed the Daedalus files on your network fileserver,
and need only to consider moving a few items to finish setting up the files on
your fileserver:

1. You may want to remove the installer application called Daedalus Write
Installer. Write is a stand-alone version of the same Write that appears
within the Daedalus 1.4 program. It is included so that you may distribute
it to your users. The files they create with this stand-alone program are
completely compatible with the Daedalus Integrated Writing Environment.
You can make this installer available to your site in whatever way is con-
venient. If you do not want users copying the files from the DIWE 1.4 Net
folder, you should move it to another location.

NOTE: Some sites prefer to put this installer in a different location so that
students are not navigating to the DIWE 1.4 Net folder.

2. You may also want to move the Documentation Folder so that users do
not have to navigate to the network fileserver to access these files. The
Documentation folder contains copies of the three program manuals.
Since these files are not used by the program, you can put them any-
where on your network which is convenient. You might move the Users
Guide in a location which is accessible to everyone at your site while
keeping the Instructor's and Administrator's Guides in a more secure loca-
tion so that students do not have access to the material in these files.

3. After deciding upon the location of these files, move on to the "Setting
Up Your Workstations" Section of this Guide.

If You Decompressed the Program Files on a Workstation

If you decompressed the program files on a workstation, you'll need to move the
network files from workstation to the fileserver by following these steps:

1. Make sure you are logged into your network from the workstation with full
read/write privileges, since you will be creating many folders on the file-
server.
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Step
Six

2. Copy the DIWE 1.4 Net Folder onto the network fileserver by dragging its
image from the hard disk into the fileserver icon.

3. You may rename this folder anything you want, and you can place this
folder as deeply within other folders as you like. Most of the enclosed
folders and files that come with the system must remain in this folder and
may not be deleted or renamed (Failure to observe these guidelines may
cause DIWE to work incorrectly).

NOTE: While you can name this network folder anything you desire, this
documentation will continue to refer to the folder as the "DIWE 1.4 Net
Folder."

4. You may want to remove the installer application called Daedalus Write
Installer. Write is a stand-alone version of the same Write that appears
within the Daedalus 1.4 program. It is included so that you may distribute
it to your users. The files they create with this stand-alone program are
completely compatible with the Daedalus Integrated Writing Environment.
You can make this installer available to your site in whatever way is con-
venient. If you do not want users copying the files from the DIWE 1.4 Net
folder, you should move it to another location.

NOTE: Some sites prefer to put this installer in a different location so that
students are not navigating to the DIWE 1.4 Net folder.

5. You may also want to move the Documentation Folder so that users do
not have to navigate to the network fileserver to access these files. The
Documentation folder contains copies of the three program manuals.
Since these files are not used by the program, you can put them any-
where on your network which is convenient. You might move the User's
Guide in a location which is accessible to everyone at your site while
keeping the Instructor's and Administrator's Guides in a more secure loca-
tion so that students do not have access to the material in these files.

6. Once you've copied the DIWE 1.4 Net folder to your network fileserver,
delete the copy from the workstation you're working at by dragging the
folder to the trash can and choosing the Empty Trash... command from
the Special menu.

NOTE: Only one copy of the DIWE 1.4 Net folder can exist at your site.
It's imperative to delete this copy from your workstation after copying it to
your network file server. The networked messages and filesharing func-
tions of the program will not work properly if more than one copy of these
files exists at your site.

Setting Up Your Workstations

The Daedalus folder which contains the program and its supporting help files and
dictionary files needs to be copied to every workstation at your site. Many of
these files are "single-user" files % that is, they can only be used by one user at
a time. Because these files cannot be used by several users at a time, they
must be copied to each workstation for the program to work properly.

There are two options for copying the Daedalus folder to your workstation.
Choose whichever is best for your situation.
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Drag-Copying the Daedalus Folder to Your Workstations

1. Copy the Daedalus Folder onto each workstation in your classroom by
dragging its image from the hard disk of the fileserver into the hard disk
icon for each of your workstations (the hard disk icon is the icon which
appears in the upper right corner on the desktop of each workstation).

2. You may rename this folder anything you want, and you can place this
folder as deeply within other folders as you like. The enclosed folders
and files, however, must remain in this folder and may not be deleted or
renamed (Failure to observe these guidelines will cause DIWE to work in-

correctly).

NOTE: While you can name this network folder anything you desire, this
documentation will continue to refer to the folder as the "DIWE 1.4 Net

Folder."

3. To make the program easily accessible, you can make an alias to the
program which you copy to the desktop of the workstation. To make an
alias, highlight the DIWE 1.4 application (the maze icon) in the Daedalus
folder on the workstation, and choose the Make Alias command from
the File menu. Once the alias is created, you can drag it onto the work-

station's desktop.

4. Additionally, use the Chooser command under the Apple menu to mount

the file server disk on each hard drive

Click the square to the right of the server name so that the file
server disk will be opened at system startup time

If you're logging into the server with a user name and pass-

word, click in the circle beside "Save my

Name and Password"

so that you won't have to enter the password on the machine

every time the machine is restarted.

5. Repeat this process until the Daedalus folder is copied to every worksta-

tion in your classroom.

NOTE: Once you finish this section, you're ready to move on to the "Setting

Permissions" chapter.

Installing the Daedalus Folder from the Installation Diskettes

1. Make sure that you have full read/write/create/delete rights to the drives on
the workstation where you are installing the software. (See the "Setting Net-
work Permissions" section for information on the specific permissions required
for your network. Check with your network administrator if you're unsure how

to set network permissions.)
Insert Daedalus Disk 1 in your workstation's floppy drive.

Double-click on the Set up file to begin the installation process. Its icon should

look like the following:

&

W
Setup
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4. The installer will display a splash screen indicating the program's name and
some copyright information. Click the Continue button.

5. The installer next shows a read-me file which explains how to choose installa-
tion locations for your machine. After you've read this information, click the
Continue button.

6. In the next window, you will choose installation options. The pop-up menu in
the upper left corner of the screen should read Easy Install. Change this
menu option to Workstation Installation.

7. In the lower middle of the Setup Dialog, use the Switch Disk button to select
the hard drive on your workstation where the installer will install the program
files.

8. (Optional) Choose the Select Folder option from the drop-down menu to
choose a specific location on the drive you've chosen. If you accept the In-
staller's default, the Daedalus Folder will be copied directly to your hard drive.

9. Click the Install button in the lower right corner to install the files. Choose the
Quit button if you want to exit the installer without changing your hard drive.
The installer will decompress the files automatically.

10. Insert additional diskettes as prompted, and follow the on-screen instructions
to complete your installation.

11. To make the program easily accessible, you can make an alias to the pro-
gram which you copy to the desktop of the workstation. To make an alias,
highlight the DIWE 1.4 application (the maze icon) in the Daedalus folder on
the workstation, and choose the Make Alias command from the File menu.
Once the alias is created, you can drag it onto the workstation's desktop.

12. Additionally, use the Chooser command under the Apple menu to mount the
file server disk on each hard drive

Click in the square to the right of the server name so that the
file server disk will be opened at system startup time

If you're logging into the server with a user name and pass-
word, click the circle beside "Save my Name and Password"
so that you won't have to enter the password on the machine
every time the machine is restarted.

13. Repeat this process until the Daedalus folder is copied to every workstation in
your classroom.

NOTE: Once you finish this section, you're ready to move on to the "Setting
Permissions" chapter.

Installing Custom Packages

The software installer includes four custom installation options. The default Easy
Install option decompresses the folders and files sites need to set up their sys-
tems originally. These custom options can be useful when changing options in
your lab or setting up special workstations. To select one of these options, follow
the basic instructions in the "Decompressing the Software" section, logging on to
the machine which is appropriate for your needs. Indicate the custom package
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you want to install by choosing the option you desire from the pop-up menu
when you reach step 7.
Fileserver Installation
Decompresses the DIWE 1.4 Net folder only. Use this option if you need a
fresh copy of the network files for your fileserver.
Workstation Installation

Decompresses the Daedalus folder only. Use this option to setup worksta-
tions at your site from the installation diskettes. Step-by-step instructions for
installing this custom package are available in the preceding "Installing the
Daedalus Folder from the Installation Diskettes" section on page 22.

Documentation Package

Decompresses the Documentation folder only. Use this option to access the
Documentation files as needed, or to setup a network copy of the documents
for users at your site.

Instructor Package

Decompresses files most often used by those teaching with DIWE:
PromptManager and the Documentation folder. Use this option to install
these files on a teacher's workstation.
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Chapter

5

Setting Permissions

Network Security

| Ell Once DIWE is installed, you'll need to set the network permissions for the files

and directories. DIWE 1.4 is based on a text-sharing pedagogy which assumes
that students and instructors will be creating documents and messages on a
network server's hard disk. In order to create and modify files on the network,
the program must have network access rights to the directories containing the
Daedalus software.

Step Assigning Permissions to DIWE 1.4 Net

One In general, the program needs full network permissions to the DI VE 1. 4 NET
directory and all its subdirectories on the server. Specific permissions and the
way they are set vary depending on the network software you're using. To
ensure the software functions properly, you'll need to set the following net-
work permissions:

AppleShare See Files, See Folders, Make Changes
Novell Netware 2.x Read, Write, Create, Open, Search, Modify, Delete,
Parental

Novell Netware 3.1 or 4.x | Read, Write, Create, Erase, Modify, File Scan

Windows NT 3.5 or Read, Write, Execute, Delete
higher

Please note that the software has not been specifically designed to work with
restricted privileges, and unpredictable problems and failures may arise if a
system administrator chooses not to follow the standard requirement of full
access to all directories.
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Step
Two

Step
Three

Step
Four

Assigning Permissions to Daedalus Folder

The Daedal us Fol der contains two subdirectories (Hel p and Proxi nmity)
and three files (DVE 1.4, Installer Log File, BiblioGCte Sanple).
The simplest way to assign permissions to these resources is to assign all us-
ers full permissions to the Daedal us Fol der, following the guidelines for
your network operating system in the proceeding section on permissions for
the DIVE 1.4 Net Fol der.

You can, however, set more restrictive permissions to protect these files and

directories, following the guidelines in this table.

Directory or File

Description

Recommended Permissions

BiblioCite A Sample biblio- Read-Only for Administrators,
Sanpl e graphical data- Teachers, and Students

base

The program itself Read and Execute Program for Ad-
DIVE 1.4 ministrators, Teachers, and Students
\ HELP On-Line help files Read-Only for Administrators,

Teachers, and Students:

Installer Log
File

A system file used
by the installer

Read-Only for Teachers and
Students
Read and Write for Administrators

\ PROXIM TY

Language files
used for the Spell

Read-Only for Administrators,
Teachers, and Students

Check, Dictionary,
and Thesaurus.

Assigning Permissions to Documentation Folder

The Docunentation Fol der contains: three files (USER RTF,
| NSTRUCT. RTF, and ADM N. RTF). The simplest way to set permissions for
these three files is to allow all users Read-Only access to the files. Alter-
nately, you can allow students no access to the | NSTRUCT. RTF and
ADM N. RTF files, as they will not need the commands and information which
are dealt with in these guides.

Setting More Restrictive Permissions for the
Question Series Folder

The Question Series: folder in the DIWE 1.4 Net Folder on the fileserver contain
fourteen basic prompt files — ten Invent files and two Respond files. Additionally,
teachers will place any customized prompts which they write for the program in
these directories so that the questions will be available to students in the pro-
gram. You can set additional access rights for these directories and files to help
protect the files.
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Setting Permissions for the Files in the Question Series Folder

To ensure that the files are not accidentally erased or overwritten, restrict access
to the following files to Read-Only for all users at your site:

Expl oring Ideas 1 Informng 1

Expl oring I deas 2 Informng 2

Expl oring I deas 3 Informng 3
Expressing Yourself 1 Local Revision
Expressing Yourself 2 Persuading O hers 1
Expressing Yourself 3 Per suadi ng Gt hers 2
A obal Revi sion Per suadi ng Ot hers 3

Setting Permissions for the Question Series Folder

Teachers at your site need to have full permissions to the Question Series
folder so that they can add or change any customized prompts which they com-
pose.

Make sure that teachers can read, write, create, and delete files in the Ques-
tion Seri es folder, but restrict the teachers' access to the original fourteen files
listed to Read-Only — Teachers do not need to be able to Write to these files nor
to Delete the files.

NOTE: Student Access to the Questi on Seri es folder

Students can be limited to Read-Only access to the Questi on Se-
ri es folderin the DI WE 1. 4 Net Folder. Students will save their
work to their own personal diskettes or directory, so they do not
need Write, Create, or Delete permissions for these particular net-
work locations.

Protecting Network Files
Step

Five Because DIWE 1.4 requires permissions which allow everyone to write to and
delete files, special precautions need to be taken to ensure that files are not
damaged by someone working with the program's network files. There are four
ways to help make sure that your files are secure:

1. Make frequent backups.

All the files in all the directories within the DI WE 1.4 Net Fol der should
be backed up regularly, on a daily basis if possible, so that no more than
one day's work will ever be lost in the case of a computer malfunction or
accidental erasure.

2. Set students' network permissions ONLY to the DI W\E 1. 4 Net Fol der and
its subdirectories.

While students need full permissions to files and directories in the DI V\E
1.4 Net Fol der and all its subdirectories, they don't need access to the
entire server. You can set students' log in to the network so that they ac-
cess only the DI VVE 1.4 Net Fol der and its subdirectories with full
permissions, but with more limited permissions to other files on your
server.
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3. Hide the Network directory so that users are less likely to find it.

Hiding the directories or their icons does not provide any true level of se-
curity; however, by hiding files, you can make it less likely for users to
make changes accidentally to files on your network. You can use Re-
sEdit or a similar program to hide the directories so that they will be less
noticeable from the Finder (remember YOU need to be able to find these
files however).

4. Mount the server at program launch and unmount upon quitting the program.

Since students need network permissions to these files only while working
with the program, you can use Applescripts to mount the server with full
permissions at program launch, and unmount the server or reduce per-
missions when the program is quit.
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Chapter

6

Printing & Distributing
Program Documentation

DIWE 1.4 comes with three printable program guides which should be printed
and distributed at your site.:

To print these guides, you'll need a word processing program which supports Rich
Text Format (RTF). Programs which can open and print the guides include Mi-
crosoft Word 6.0, or 7.0 (for Windows 95), Word Perfect 6.0 or 7.0, Word 97, and
Microsoft Office 97.

If you don't have access to one of these word processors, you can download Ac-
robat versions of the documentation which you can view and print using the Ac-
robat Reader. You can download the Adobe Acrobat reader from
http://www.adobe.com/prodindex/acrobat/readstep.html. Adobe Acrobat copies
of these guides are available at http://www.daedalus.com/tech/docs.html.

Printing RTF Guides

There are three files which you'll need to open and print:

Users. RTF The User's Guide
I nstruct. RTF The Instructor's Guide
Adm n. RTF The Administrator's Guide

These files use three fonts % Helvetica, Courier, and WingDings. If your com-
puter is missing one of these three fonts, pagination and layout in the text may
be incorrect.

To obtain the best results, open each of the files and follow these guidelines be-
fore printing your guides:

Set your word processor so that Hidden Text is not displayed. In Microsoft
Word 6.0 or 7.0, you'll accomplish this by choosing the Options... command
under the Tools Menu. Choose the View tab in the dialog which is dis-
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played, and be sure that there is no X in the checkbox beside "All" and be-
side "Hidden Text" in the Nonprinting Characters area.

Set your word processor so that Hidden Text is not printed. In Microsoft Word
6.0 or 7.0, you'll accomplish this by choosing the Options... command under
the Tools Menu. Choose the Print tab in the dialog which is displayed, and
be sure that there is no X in the checkbox beside "Hidden Text" in the In-
clude with Document area.

Set your word processor so that Drawing Objects are printed. In Microsoft
Word 6.0 or 7.0, you'll accomplish this by choosing the Options... command
under the Tools Menu. Choose the Print tab in the dialog which is dis-
played, and be sure that there is an X in the checkbox beside "Drawing Ob-
jects" in the Include with Document area.

Distributing the RTF Guides

The print documentation includes all the information which is available in the on-
line program and teacher help files. Students and teachers at your site can
benefit from access to these guides. :

The following distribution is recommended:

Who? Which Files? The Guide Names?
Students Users. RTF The User's Guide
Teachers Users. RTF The User's Guide
I nstruct. RTF The Instructor's Guide
Lab Workers Assisting | Users. RTF The User's Guide
Students and Teach- I nstruct. RTF The Instructor's Guide
ers with basic tasks
Lab Workers Assisting | Users. RTF The User's Guide
Students and Teach- I nstruct. RTF The Instructor's Guide
ers AND helping to Adm n. RTF The Administrator's Guide
supervise the site
Site Administrator Users. RTF The User's Guide
I nstruct. RTF The Instructor's Guide
Adm n. RTF The Administrator's Guide

The User's, Instructor's, and Administrator's Guides may alll be reproduced by
licensed sites, provided that the guide's copyright page is included. To help pro-
vide students access to the User's Guide, your school might place several copies
of the document on reserve at the library, arrange for students to obtain copies
through a local photocopying service, or place the files in a shared location on
your network which students can access.
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Chapter

5

Setting Up Your Site

DIWE 1.4 comes with one default Instructor (The Staff), Class (Administration),
and user (The Administrator). To set up the program for your site, you will need
to add instructors and classes for those who will use the software. This section
includes a quick overview of how to log into the program, set your site's adminis-
trator password, and set up and maintain classes.

Logging into DIWE 1.4

&=

1. Double click on the Daedalus maze :icon (shown left) to start the program.

2. You'll see a File-Open Dialog box asking you to locate the Daedal us Pref -
erences file. Navigate to the DI WE 1. 4 Net folder on your network file-
server, highlight the Daedal us Pr ef er ences file, and click the OK button.

NOTE: This process will only happen once on each workstation. After you
locate the Preferences file, the location of this file is written into a file called
Daedalus Config, which will be created in your workstation's System Folder.

3. After the splash screen, you will see the Login window. Each user is associ-
ated with an instructor and a class. There is one default instructor called The
Staff, with one default class named Administration. To begin with, there is
only one default user, The Administrator. Click each of these options in turn,
then choose the Log In button.

4. Type the default Administrator's password: admni n

5. After logging in as The Administrator, you will see a message indicating the
following: "The instructor has not subnitted a class assi gnnment
for today." Dismiss this box by clicking the OK button, and you will see
DIWE's menubar and the Launcher (a palette of buttons for the basic tools in
the program).
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Making your Site's Password Secure

Once you've logged in, the first thing you should do is change the Administrator's
password to something more secure. DIWE 1.4's default password for the Ad-
ministrator — admin — is powerful since it gives users who know it the ability to
log into the system and makes changes such as setting up classes or changing
user passwords. Since this guide containing the password is available widely,
you should change the administrative password to something less obvious im-
mediately for security reasons.

To change the Administrator password, follow this process:
1. Choose the Change my password... command from the Utilities menu.

2. Type a new password in the dialog which appears. Passwords are limited to
eight characters and are case sensitive.

3. Click the OK button.
4. Type your password again to confirm.

5. Click the OK button, and your password will be changed.

Adding an Instructor

For each instructor who will use DIWE at your site, you'll complete the following
steps to set up classes:

1. Select the Add an Instructor... command from the Instructor sub-menu
under the Utilities menu.

2. DIWE will display the following screen which contains entry fields for all
the information about the new instructor.
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Add An Instructor

|Enter’ the instructor's full name, a password, and the instructor's c]asses.l

Instructor's Full Name: A Password:
Martha Lucas Tychd
Classes
Rhetoric 201 4
Rhetoric 302

| |[Remove |

[ Add |

Add Instructor,

3. Type the instructor's name in the first field, below the label
"Instructor’'s Full Name." The name you type will be the teacher's
login name, so use whatever name the teacher prefers to use with stu-
dents (e.g., Dr. Kelli Drewry, Eryk Myckel, Mr. C. Smith)

4. Type a password for the instructor in the field below the label " A Pass-
wor d." Either assign the instructor a password, or better yet, ask the in-
structor to provide a password that she or he will remember. Either way,
the instructor can use the Change my password... command later to
choose another password.

5. Assuming that no classes have been entered yet, type the course
number or title in the single-line field to the left of the Add button.

6. If you enter a class incorrectly, just click on the Remove button and it will
delete the class from the instructor’s list.
Select the Add button to add the class.

Continue this process until you have entered all the classes for the in-
structor.

9. Select the Add Instructor button to complete the process and set up the
necessary files and folders for the instructor.

DIWE 1.4 33 Administrator's Guide



Adding a Class when the Instructors’ names are already
entered

If the instructor's name appears on the instructor list (you would see the instruc-
tor's name on the DIWE log-on screen), you'll use a different process from that
you used to set up the instructor's classes originally:

1. Select the Add a Class command from the Class sub-menu under the
Utilities menu.

2. Highlight the name of the teacher you'll be adding a class for in the next
screen which appears:

Choose an Instructor to
add a class to.

Michael O'Connar
FPeter McBride
The Staff

Click the OK button.

In the next dialog which appears, you'll see a list of the current classes for
the instructor you've chosen.

5. Type the course number or title in the field below the label "Nane of New
C ass."

6. Type a password for the instructor in the field below the label " A Pass-
wor d."” Either assign the instructor a password, or better yet, ask the in-
structor to provide a password that she or he will remember. Either way,
the instructor can use the Change my password... command later to
choose another password.

NOTE: the instructor will need to use the password you choose to log into
the new class.

7. Click the Add Class button to add the class.
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Removing Users, Instructors, and Classes from the Login

System

From time to time, a user, instructor, or class at your site will need removed from
the system %, perhaps it's a student who is no longer in the class or an instructor
and class you created for testing and no longer need in the system. Follow these
steps to remove a user from the login for any class at your site:

1. Choose the relevant Deactivate command, as indicated:

To Remove

Choose

From

A User

Deactivate a User com-
mand

the Users sub-menu un-
der the Utilities menu

A Class

Deactivate a Class com-
mand

the Classes sub-menu
under the Utilities menu

An Instructor

Deactivate an Instructor
command

the Instructors sub-menu
under the Utilities menu

2. Follow the on-screen instructions to remove the user, instructor, or class:

To remove a user, you'll choose the Instructor and Class, then the
User name

To remove a class, you'll choose the Instructor and then the Class

name

To remove an instructor, you'll choose the Instructor name.

NOTE: This change is not permanent. If you need to return a user, instructor
or class to the system's login, use the Reactivate command.

Correcting Typos in a User's, Instructor's, or Class Name

If a user makes a typo while logging in or has a name change, follow these in-
structions to change the name in the login files

1. Choose the relevant Rename command, as indicated:

To Rename

Choose

From

A User

Rename a User command

the Users sub-menu un-
der the Utilities menu

A Class

Rename a Class com-
mand

the Classes sub-menu
under the Utilities menu

An Instructor

Rename an Instructor
command

the Instructors sub-menu
under the Utilities menu

2. Follow the on-screen instructions to rename the user, instructor, or class:
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To rename a user, you'll choose the Instructor and Class,
then the User name

To rename a class, you'll choose the Instructor and then the
Class name

To rename an instructor, you'll choose the Instructor name.

3. Type your correction in the next dialog that appears, and click the OK but-
ton.

Changing a User's Password

If a user has forgotten his or her password, or if the password has been discov-
ered by someone else, you may want to change it. You'll follow these steps
whether you're changing a password for a student or an instructor.

To change a user’s password:

1.

Select the Change a User’s Password command from the Users sub-menu
under the Utilities menu.

In the dialog which appears, choose the Instructor and the Class where the
user is registered.

Next, select the name of the specific user.

Type in the new password in the next dialog that appears, and click the OK
button

Type the password again to confirm the change, and click the OK button.
The next time that user logs in, he or she will need to enter the exact pass-
word you typed.

Changing a User's Level

If you have computer lab workers who are not instructors but who need access to
instructor utilities (such as Compact InterChange, for example), they should log in
as users. You can then give them access to instructor utilities:

1.

Select the Change a User’s Level command from the Users submenu un-
der the Utilities menu.

In the dialog which appears, choose the Instructor and the Class where the
user is registered.

Next, select the name of the specific user.
Click the proper level (user, instructor, or administrator).
Click the OK button.
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Starting a New Semester

At the end of a semester, you will probably want to do a couple of administrative
things. You are going to archive all the semester’s work and then wipe the slate
clean for the next semester.

Archiving Your Current Files

The folder structure of DIWE makes it very easy to archive your semester. If your
copy of the DIWE 1.4 Net folder for the semester is on a local hard disk, all you
need to do is copy the | nst ruct or s folder by dragging it from the server to the
hard disk. This will be an exact copy of the end of the semester’s files, and this
archive may be accessed at any time by running a copy of DIWE that uses these
files instead of the network ones.

Alternately, you can highlight the | nstruct ors folder on your file server, and
select the Duplicate command under the File menu to make an archive of the
folder on your server.

If individual instructors want their own archive copies, they should drag a trun-
cated Instructors folder to a diskette or hard disk. This folder should include only
the Instructor list and their own folder.

Starting a New Semester

To setup a new semester, you should replace the Instructors folder on your net-
work server with a fresh copy of this folder. No users or instructors will remain—
you will need to follow the instructions earlier in this guide to add instructors and
classes after you complete this process.

1. Archive your existing Instructors folder, following the instructions above.

2. Change the name of your existing | nst r uct or s folder to something like | n-
structors (A d) orlnstructors (Fall 1997).

3. Navigate to the I nstruct ors ( CLEAN) folder in the Cl ean Copi es directory
in the DI WE 1. 4 Net folder.

4. Choose the Duplicate command under the File menu to make a copy of the
Instructors folder. The new copy will be named | nst r uct or s( CLEAN) COPY.

5. Click on the Instructors(CLEAN) COPY folder's name so that it's high-
lighted.

6. Move your cursor to the end, and backspace over the letters so that the
folder is named | nstruct or s — No extra spaces or letters.

7. Double-click on the maze icon and you should be able to log in to the pro-
gram using the original default user and password (The Administrator and
admin).

8. Follow the instruction in the "Adding an Instructor” section on page 32 to set
up instructors and classes for your new term.
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Chapter

8

Understanding DIWE's
File Structure

File and Folder Description

There are three locations where Daedalus Files are stored:

4

On the Network
Fileserver

=2

On the Workstation
Hard Drive

o

In the Workstation's
Syst emFolder

DIWE 1.4

The DIVWE 1.4. NET folder and the folders and files
which it contains should be located on your network file-
server, and ONLY on your network fileserver. Addition-
ally, the Docunent ati on folder can exist on your net-
work fileserver, though you can move this folder to an-
other location if it's more convenient (see "Setting Up
Your Fileserver" on page 20 for more details).

The Daedal us folder and the files and folders which it
contains should be located on the hard drive of every
workstation in your classroom. Because some of the
programs in this directory are single-user applications,
the Daedalus folder must be on the workstations — it
cannot be shared.

The Daedal us Config file should be located in the
Syst emfolder on every workstation where the Daedalus
folder is copied. This file enables the program to
“remember” where to find the Preferences file on the
server on subsequent log-ins.

NOTE: The program creates this file the first time DIWE
is launched on the machine. You should not copy the
Confi g file from another machine at your site.
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DIWE 1.4 Folder Structure

The DIVE 1.4 Net folder contains the following folders and files:

=l=——— DIUE 1.4 Net =———2I=
& itemns 9137 MB in dizk 23 MB availabls
O A -
Instructors FPrompttlanager
Question Series Clean Copies
j w~
Daedalus Preferences Laedalus Write Installer

T
@ [

The C ean Copi es folder contains fresh copies of the Files in the In-
structors folder.

The Daedal us Wite Install er is an installer file for the stand-alone
version of Write.

The | nst ruct or s folder (described more completely below) contains the
folders and files necessary for file sharing and network communication.

The Question Series folder contains prompts used in Invent and Re-
spond.

The Daedal us Pref er ences file is the network preferences file.
Pr onpt Manager is a SuperCard application used to customize prompts.

The Instructors Folder

Inside the Instructors folder are folders for every instructor, including one to be
shared by everyone (InterClass). The Instructor List file contains a list of all in-
structors and the classes they teach; it is modified every time you add an instruc-
tor or class.
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S [==———-= Instructors =——=03|

& iterns 29 288K in disk &4 445K awvailable

iis
[[]InterClass [CJRalph Smith —
[[ T The Staff [[erry Garcia

D Instructor List |n__|l‘~“|ar'1'a Lorca

o
=] 5|

In the following example, we are looking at the two courses that Garcia is teach-
ing. The individual course folders are created whenever you add a class to an
instructor, or when you create a new instructor.

=S[[=—— Jerry Garcia ——=H15|
2 itemns 29 288K in disk &4 443K available
in

[~ |Engtish 101 [[T)Britizh Lit

o
] e

Going further down the hierarchy, the following example shows the folders found
within every course folder in the Daedalus system. Documents contains all the
papers that have been turned in during the semester—it is the folder from which
users View or Copy a file. Users contains a list of all users, including the papers
belonging to each one.

ElleVV— English 101 EEEI
S iterns 29,288k in dizk &4 445K available
|n__|Du:-cument5 |n__|U59r'5 i

[[]InterChange [[JClazz Assignment

il
I
] B

Mail and InterChange folders, in turn, contain folders for each conference that is
open. In this example, we see four Mail conferences.
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S———= Mail —xF

4 qterns 99,288K in disk &4 445K ava

|'=__|I‘~“Iain |"__|Ean:e i
DGender |'__|I21355

T

] [

Here is an example of the Class Mail conference. Individual mail messages have
randomly generated names, and are referenced by the List file as long as they
are not deleted. When a user deletes a message, its reference is removed from
the List file and moved into the Archive file, so that the messages are not actually
deleted. If an instructor or supervisor deletes an item from the Archive file, then
the file and the list record are both deleted at that time, and the individual mes-
sage is now completely deleted.

The InterChange Conference folders operate similarly, except that the files exist
for very short periods of time, or until someone Compacts that InterChange con-
ference. When this happens, all the messages are appended to form the tran-
script file, then are deleted from the conference; the conference folder itself is
finally deleted, as well.

S[(==———(lass —er———|
2 iterns 29, 288K in disk &4 445K available
[(ist Z7I7EIEE4 22106349321 iy
[ ] rchive 2546472440 21841 266335
7110287829 ZE4E194TET 71810535322

=l =

=l
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Daedalus Folder Structure

The Daedal us folder contains the following folders and files:

EI=—= Daedalus Folder == |

4 jtermns 91Z .4 MB in disk 25 3MB avaﬂal]

G

DIWE 1.4

&>

9 09

Help Proximity

T
2] EE

The Bi bl i oCi t e Sanpl e file is a sample BiblioCite database.

The DI VE 1. 4 is the Daedalus program itself

The Hel p Folder (described in details on the following pages) contains
the online program help files used by the program.

The I nstaller Log Fil e is a system file which keeps details on the
software you've installed

The Proxi m ty Folder (described in details on the following pages) con-
tains the several files used for spellchecking, the dictionary, and the the-

saurus

The Help Folder

The Help folder contains the Help engine that DIWE 1.4 uses, as well as DIWE’s
help files for the user and the instructor. E-help splits help files into two parts:
the text and the media. As a result, there are two computer files for every online
document which appears in the program (e.g., User Help file and User Help Me-

dia file).
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DE HEI|] EE
9 itermns 91 Z .6 MB in disk 231 MB available

E Uzer Help E Help for EHelp
E Uzer Help Media E Help for EHelp Media

[

E Instructor Help ﬁEHvah'I|:-En-;|inva~'““1 4.0

E Instructor Help Media DE}:trai
E Character Help DHandh-:--:-k;
E Character Help hMeadis E

=l [

The Char act er Hel p File and Medi a File provide online help with ac-
cents, foreign characters, and special symbols.

The E- Hel p Engi ne 4.0 is the Help Program.

The Hel p for E-Hel p File and Medi a File provide online help with Pro-
gram

The I nstructor Hel p File and Medi a File provide online help with
teachers and the administrator

The User Hel p File and Medi a File provide online help with the program
modules

The Handbooks folder and the Extras folder may present if your site
purchases additional program resources. These folders serve as the lo-
cation for teacher and students resources, specific to different kinds of
classes (English as a Second Language, Business and Technical Writing,
and so on).

The Proximity Folder

The Proximity folder contains language resources, which DIWE uses during spell-
checking, Dictionary, and Thesaurus operations. If you purchase languages
other than English, they will be installed here, as well. These files contain infor-
mation about the environment, about hyphenation, spelling, the word list for
spell-checking (.LEX), the dictionary database (.DCT), and the thesaurus data-
base (.THS).
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SI=———= ProXimity ———pP7

2 itemns 2126 ME in disk 23 MEB awailable
[ s [ s [ Ix i
eng.clx eng.eny eng.hyp
j by ] L, L,
usa.det u=a.lex u=a.ths engphon eny
i
Q] T

Occasionally, a student will look up a word in the dictionary, then follow that defi-
nition with a query about synonyms, and the program will say that this word is not
in the dictionary. What's happening is that the original word is found in one da-
tabase, but not the other. An analogous print-based situation would be that a
student looks up a word in the dictionary then picks up a thesaurus and finds that
the word is not listed — The spellchecker, dictionary and thesaurus in DIWE are
like different books.
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Chapter

9

Customizing Your Copy
of DIWE

This section of the Guide explains how to optimize the program for your site, to
set preferences, and to customize the program's tools.

Setting Preferences for InterChange Pseudonyms

The InterChange module in DIWE allows users to choose a pseudonym, or nick-
name, by default. Usually this capability is used only when the teacher directs.
Some sites choose to turn off the option so that no one at the site can use a
Pseudonym in the InterChange module.

NOTE: This setting affects all classes at your site.
If your site would prefer not to allow pseudonyms:
1. Choose the Set Preferences command from the Utilities menu.

2. In the dialog box which appears, click the Pseudonyms Allowed checkbox
so that an X no longer appears.

To reverse your choice, click the checkbox so that the X appears in the Pseudo-
nyms Allowed checkbox.

Optimizing Network Performance for InterChange and Mail

Choose the Set Preferences command from the Utilities menu to bring up a
dialog box that enables you to make fine changes in the way these two commu-
nications modules operate on your network.
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InterChange has two configurable performance variables:

1.

InterChange waits until an interval of 2 seconds of “event-less” time has
passed before searching for new messages. So if the user is typing or
scrolling through a transcript, there will be no irritating pauses when new mes-
sages arrive. This interval, called the Event Frequency, is expressed in
60ths of a second, so that the default is 120. If you want the program to wait
a longer time before searching for a new message, increase this number.

InterChange also has a variable-length "search for message" interval, so that
new messages will be loaded up more slowly if the user is not at the very bot-
tom of the transcript window. This modification, the Idle Frequency, was
added to improve performance when the user is reading messages early in
the transcript and doesn't care if they see the up-to-the-minute messages as
they arrive. This interval, the Idle Frequency, is also expressed in 60ths of a
second—its default value is 60 (or 1 second). If you want the program to wait
a longer time before loading these messages at the bottom of the session,
increase this number.

Mail has three configurable variables:

1.

The Compact Threshold refers to the number of deleted messages that a
Mail list can have before it automatically cleans the list and moves these un-
used items to its archive list. The default is 250. This compacting command
can be invoked by a teacher or administrator from the Mail menu—it is
probably better to do it manually than to wait for Mail to determine it is time to
compact its list (See "Optimizing the Mail List" in the Instructor's Guide for in-
structions).

The Idle Frequency determines how frequently Mail should check the net-
work for new information (in 60ths of a second). The default number is 900
(or 15 seconds). Since Mail doesn't attempt to simulate "real-time" informa-
tion, there is no reason for this number to be 60 (as it is for InterChange). If
you have a fast network like Ethernet, and you are doing a lot of in-class Mail
writing, you may want to lower this number so that your Mail lists are instantly
up-to-date.

The “Maximum Tries to Open List” number refers (as the name implies) to
the number of times Mail should try to open a list on the network. Normally,
Mail opens a list on the first try, but sometimes network traffic is busy or
someone is currently writing a new message to the list or deleting an old
message, so Mail loops back to try again. In situations of extremely heavy
network traffic, this default of 7 may need to be extended. The only possible
problem with a higher number might be that Mail would sit waiting for the list
to open, preventing the user from doing anything else.
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Using DIWE with At Ease

Many sites, tired of their students throwing away critical files, turning off the net-
work, or simply playing with desktop patterns and Macintosh sounds, have opted
to run Apple Computer's At Ease. At Ease restricts the access of individual users
of a single Macintosh computer. It can prevent unauthorized access, moving,
renaming and deleting of files.

In order to use DIWE with At Ease, follow these steps:

Install and Configure DIWE

1.

Install At Ease

If you have already installed At Ease, disable it by opening At Ease Setup
and selecting the Off button. Then, restart your Macintosh.

If you have not installed DIWE, do so now, following the instructions in Chap-
ters 4 through 6.

Use the Chooser command under the Apple menu to mount the file server
disk on each hard drive

Click in the square to the right of the server name so that the file
server disk will be opened at system startup time

If you're logging into the server with a user name and password, click
in the circle beside "Save my Name and Password" so that you won't
have to enter the password on the machine every time the machine
is restarted.

If you have not logged into DIWE from this Macintosh, do so now, following
the instructions on page 31. After logging in once, you should be able to run
DIWE without being asked to locate the Daedalus Preferences file.

When you finish these steps, the workstation should already be able to
launch DIWE, that the program no longer asks the user to locate the
Daedal us Preferences file.

Next, install AT EASE using the installation diskettes and configure it to run as fol-
lows using the ATEASE Set Up program:

1.
2.

Open the ATEASE Set Up program.

Add a new user (someone who will be using the computer) and specify a user
name and password. If you prefer, you can assignh a user name to each ma-
chine with a login or choose user names for each person who will log in at
your site.

Determine whether or not you want the user at your site to be able to use the
finder or to work only within the AT EASE program. DIWE is capable of oper-
ating using either configuration. If you allow access to the finder by the user,
please refer to the documentation provided with DIWE. If however you
choose to allow the user to operate under solely the AT EASE program, select
Stay in At Ease and then click on Next. Now, select Add Application and
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locate the DAEDALUS program on the local hard drive. Add the Daedalus pro-
gram to the "lItems for this User" before clicking on the OK button.

4. Click on Next. Here you may choose to give your students access A) any-
where, B) only to a folder created for them on the hard disk, or C) only to their
diskette. If you are truly concerned about network security, you're probably
going to choose option B) or C). Click on Done and select On at the top of
the AT EASE window.

5. Next, set up the Question Series folder: If you have allowed an At Ease user
to open and save files only in his or her user's folder or only on disk, you must
make a special copy of the Question Series folder. This copy should be
placed in the user's folder or on a floppy disk, respectively. This will allow the
user to select a question series when using Invent or Respond.

6. If you disabled At Ease in Step 1, enable it now by opening At Ease Setup
and selecting the On button. Then, restart your Macintosh.

Customizing the Concordance

DIWE's concordance gives writers a list of all the words they have used, both in
order of frequency and alphabetically. In addition, the concordance compares the
words used in the document to specific word lists.

The program maintains six word lists to calculate diction statistics. These lists can
be modified to suit your needs. All the words and headings for these lists are
stored in STR# resources in the DIWE program itself, and can be accessed easily
by using a program like Apple Computer's ResEdit.

A MAKE A COPY OF DIWE BEFORE YOU BEGIN TOUCHING ITS RESOURCES.
Modifying the wrong resource may cause your program to fail.

When you open the program in ResEdit, open its STR# resources; the Concor-
dance uses 7 resources, all of this type.

STR# 1989 is a list of the headings for the other 6 word lists below.

The 6 lists are in these resources. The default categories are listed, but there is
absolutely no requirement to use them.

STR# 1900 To Be Verbs

STR# 1901 Relative Pronouns

STR# 1902 Pronouns

STR# 1903 Prepositions

STR# 1904 Coordinating Conjunctions
STR# 1905 Possibly vague terms

Each of these 6 lists can have as many words on it as you want. You can add to
existing lists, or completely redefine a list. You should be aware that each addi-
tional word slows down performance slightly; a single new word would be imper-
ceptible, but if you add 50 words to each of the 6 lists, the concordance's per-
formance would be noticeably slower.
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Example 1

You want to add three more words to the "Vague" list, or STR# 1905. Since the
heading "Possibly Vague Terms" already exists in resource 1989, you don't have
to modify it. You open 1905 and add these three words (in ALL CAPS) to the
list. (The program expects capital letters, so lower-case could cause unpredict-
able results.)

Example 2

You want to replace word list 1904 (currently "coordinating conjunctions") with a
special list of Sexist words.

1. In STR# 1989, you need to change the heading from "Coordinating Conjunc-
tions" to "Possibly Sexist Terms" (or whatever you want to call this list).

2. You replace the words in 1904 with your own (in ALL CAPS, please). You are
not restricted to using the same number as before—you can have a smaller or a
larger list.
When you now perform a word-list on a text, the statistics will look like this:

To Be Verbs 424 = .04%

Relative Pronouns 55 =.01%

Pronouns 227 =.12%

Prepositions 31 =.01%

Possibly Sexist Terms 666 =.16%

Possibly vague terms 125 =.02%

Using Accented and Special Characters in DIWE

There are essentially two ways to insert foreign characters in your DIWE docu-
ments. These characters can be used throughout DIWE - for instance, in
WRITE documents, in InterChange sessions, and in Mail messages.

Key Combinations Option

Once you've launched DIWE, you can use the OPTION key in combination with
other characters to type a supported character such as a C with cedilla (¢ is op-
tion + ¢), an A with an acute accent (4 is option + e, followed by a), or pi (p is op-
tion + p).

Using Key Caps to Simplify Key Combinations

You can use the Key Caps desk accessory to learn about the keys to use in or-
der to type the characters you need. You can find an explanation of Key Caps in
your Macintosh User's Guide or use the online Apple Guide under the Help
menu.
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Using Freeware to Simplify Key Combinations

You might try installing the freeware control panel PopChar, which makes typing
these characters easier by creating a small PopChar menu in the upper left cor-
ner of the menu bar. You then pull down the menu and place the mouse pointer
over the character you want and release the mouse button — the letter is auto-
matically inserted in your active document at the location of your cursor.

NOTE: PopChar has not been widely tested, so you should check for conflicts
with other extensions and control panels. Also, the PopChar menu will be avail-
able in all your applications (not just for DIWE). You can get a copy of the free-
ware from the writer's web page:
http://infosoft.soft.uni-linz.ac.at/Staff:Blaschek.html

System Keyboard Option

Mac sets the keyboard in the KEYBOARD control panel. You can reset the key-
board for your classroom to a keyboard which uses the layout associated with the
language which your classes will need

System 7

You probably have only the US keyboard and the US - System 6 keyboard. You
can get alternate keyboards (French, Spanish, etc.) from Apple and other
sources. Once you have the keyboard you want, copy it into your system folder.
Then open the KEYBOARD control panel and choose the appropriate layout.

System 7.5 or 8

NOTE:

You probably loaded most of the European keyboards when you installed your
system software, so you will already have access to several alternate keyboards.
Simply open the KEYBOARD control panel and choose the appropriate layout.

These keyboards have a slightly different layout from the traditional US
keyboards. You can look at the Key Caps desk accessory under your Apple
menu for specifics on the layout.

Warnings Related to Changing Your Site's Keyboards

1. The biggest thing to realize is that you MUST be sure you change the key-
board back to US when your class is over so that the next class using the
classroom will run smoothly.

2. If you change the keyboard, the keys are rearranged. That has big conse-
guences that require a bit of repeating to your students: you have to use the
MOVED keys used in key commands (such as command + Q to quit). That
will make more of a difference with some keyboards than others. For in-
stance, with the French keyboard, the letter "a" is moved, which can make
choosing Command + A for Select All fail if you don't remember you have
to use the location of the A on the French keyboard — not what's displayed
on the keys themselves.. You might encourage using the MOUSE till every-
one gets used to the new keyboard layout.
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3. The other part of DIWE which might be affected if you change the keyboard
settings at your site is the login system, specifically user passwords. If you
switch keyboards during the semester, you could have some students who
would have to be shown how to type their passwords. For instance, if my
password were Car, and we switched to the French keyboard, I'd have to use
a different key for that letter "a."
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Chapter

10

Troubleshooting

This troubleshooting section includes information on the questions most fre-
guently encountered as schools set up the software. Additional troubleshooting
information is available from the Daedalus Group's WWW page. See the
"Getting Help" section for information on ways to access these and other re-
sources.

At Ease

DIWE asks users to locate the Preferences file, even though the file has
been located already (for a previous login). DIWE was running successfully
BEFORE the machines began using At Ease.

1. Make sure that the appropriate file server disk is set to be opened
automatically at startup time.

Before you turn AT EASE on, you need to use the Chooser to mount the
file server disk, click in the square to the right of the server name so that
the file server disk will be opened at system startup time, and, if you're
logging into the server with a user name and password, click in the circle
beside "Save my Name and Password" so that you won't have to enter
the password on the machine every time the machine is restarted.

2. If you have limited users' access to files they can open and save, you
have to open the DIWE folder on the server (rather than the server
disk itself).

As you set up users in AT EASE, you have a SECURITY option where
you choose where you "Allow user to open and save." The options are
the following:

* Anywhere
Opens and saves allowed in any folder on any disk.
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 Onlyin user's folder
Opens and saves are only allowed in user's folder on startup
disk.

* Only on floppy disk
Opens and saves are only allowed on floppy disks.

If you choose, ONLY IN USER'S FOLDER or ONLY ON FLOPPY DISK,
simply having the server on your workstation's desktop isn't enough since
users cannot open the file server to look for the preferences file — they
don't have access to the server's disk.

To get DIWE working, share the DIWE folder on the server and set up
your workstations to open that folder automatically.

Forgotten Administrator Password

Someone has changed the Administrator Password at your site, or it's been
forgotten. What can you do to restore the password without setting up a
new semester?

There's no way to find out what the existing password is for the administrator;
however, you can restore the original password (admin) and then change it to
something more secure.

1. Gotothelnstructors (clean) folder on your server, and make a copy of
the info you need which you'll copy to the current Instructor folder.

a. To do so, navigate to your DIWE folder on the server and
down through these folders to the User s' folder:
I nstructors (clean) folder
The Staff folder
Admi ni stration folder
User folder
b. Inside this User s folder, highlight the file User 1.
Under the File menu, choose the Duplicate command.
d. Anew file, User 1 copy, will appear in the User s folder. Drag
User 1 Copy out of the User s folder and onto the desktop.
e. Close the User s folder window by clicking on the close box.
2. Now open the location you want to copy to, and drag the old copy of
User 1 to the Trash.

a. To do so, navigate to your DIWE folder on the server and
down through these folders to the Users' folder:
I nstruct ors folder
The St af f folder
Admi ni strati on folder
User folder

b. Inside this Users folder, highlight the file Userl.

c. Drag the file Userl to the Trash can. [You can empty the
trash after you've replaced the file and made sure everything
is working]

3. Drag User1 Copy from the desktop into the User s folder (replacing the
one you have just put in the trash).

o
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4. Change the name of User 1 copy to User 1 by clicking once on the file's
name (the file name will show up in reverse —white letters on a black
background — with a white line around the box). Press the Right arrow
key to move the cursor to the end of the filename. Then use the Delete
key to backspace till the file is named correctly.

NOTE:
Be sure your delete the letters and spaces — any extra spaces at the end
of the file name or changes in the spelling and spacing of User 1 will re-
sult in the error messages "A file you need is busy. Would you like to try
again?" and then "Cannot complete your request because of a disk error"
when you try to log in as The Administrator. If you see these errors,
check the name of the file again.

5. Once you replace the User 1 file, your administrator's password will return
to the default password, and you can change it to something more se-
cure using the Change my password... command under the Utilities
menu.

Login and Program Launch

At login, getting the messages
"A file you need to use is busy. Would you like to try again?"
"Could not complete your request because of a disk error."

If you don't seen the splash screen (the copyright information):
The | nst ruct or s folder is missing, misnamed, damaged, or has the wrong
permissions.

The | nst ruct or s Folder should be in the DIWE folder. It has to be named
Instructors — no extra letters or spaces. If you think the folder is damaged,
try making a new copy by duplicating | nst ruct ors (CLEAN) and changing
the name to I nstructors . |If you're trying to login, the program is trying to
use Read permissions . Check the "Network Permissions" Chapter for the
specific permissions for your system.

Also be sure that there is only one copy of the Preferences file at your site.
The Preferences file should exist on the network fileserver, in the DIWE 1.4
Net folder only. Do not copy this file to your individual workstations.

If you see only the splash screen (the copyright information):

The I nstruct ors Li st is missing, misnamed, damaged, or has the wrong
permissions.

The I nstructors Li st should be in the Instructors Folder. It has to be
named | nstruct ors Li st — no extra letters or spaces. If you think the file
is damaged, try making a new copy of the | nstruct ors FOLDER by dupli-
cating I nstructors (CLEAN) and changing the name to Instructors
[making a new folder will replace the Instructor List]. If you're trying to login,
the program is trying to use READ permissions. Check the "Network Permis-
sions" Chapter for the specific permissions for your system.
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If you see the splash screen (the copyright information) and the login screen
and are able to choose an INSTRUCTOR and a CLASS:

A folder or file for a particular instructor and/or class is missing, misnamed,
damaged or has the wrong permissions. Try these options:

Make sure a folder for the specific instructor you've chosen is in
the I nst ruct or s folder, that the folder is named correctly, and has
the right permissions (the program needs READ permissions at this
point. Check the "Network Permissions" Chapter for the specific
permissions for your system.).

Make sure a folder for the specific class you've chosen is in the
folder for that specific instructor, that the class folder is named cor-
rectly, and that the class folder has the right permissions (again the
program needs READ permissions).

Make sure that a User s folder is located within the specific class
folder for that specific instructor, that the User s folder is named cor-
rectly, and that the User s folder has the right permissions (again the
program needs READ permissions).

Make sure that a User s Li st is located within the specific Users
folder, that the User s Li st is named correctly, and that the User s
Li st has the right permissions (again the program needs READ
permissions).

To help make this clear, let me try an example. If the instructor is
named SMITH and the class is COMP, you'd see something like
this:

| NSTRUCTCRS folder [inthe DIVE 1.4 Net folder]
SM THfolder [the specific instructor's folder]
COWVP folder [the specific class's folder]
USERS folder [the users folder for the class]

At login, one user gets the error message
“There is already a user with that name.
Please use a slightly different name."

There are two possible explanations:

1.

The user is a member of the class whose name already appears in the
scrolling list of Users; however, the person tried to log on as a new user.

Click the OK button to clear the error box, and look in the list of names
showing in the scrolling list under YOUR NAME. If the user's hame is show-
ing up in the class list, click on the correct name and enter the correct pass-

word.

This error is likely to be caused by the User double clicking on the Class
name in the scrolling list in the Your Class box (which brings up the New User
Login dialog box) OR to be caused by the User clicking on the New User but-
ton, not realizing that he or she was already a member of the class. This er-
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ror might occur, for example, in a class where an administrator set up the in-
structors or students; however, the particular instructor or student did not re-
alize that his or her name was already in the list for the class.

2. The user is a deactivated member of the class whose name does NOT show
up in the scrolling list of Users and tried to log on as a new user. —

Click the OK button to clear the warning message, and look in the list of
names showing in the scrolling list under YOUR NAME. If the user's name is
does not show up in the class list, but you see the error asking you to "use a
slightly different name," it's likely that the user is a deactivated member of
the class. As the DIWE Administrator , log in and activate the user again
(using the Users... command under the Utilities menu).

At login, one user — and ONLY one user — gets the error message
"A file you need to use is busy. Would you like to try again?"
"Could not complete your request because of a disk error."

The user file associated with this person is missing, misnamed, damaged, or has
the wrong permissions. Try these options:

1. Go to the folder for the specific instructor and class which the user belongs to
and choose the Users folder. Inside that folder you should find a Users
Li st and a User s file (named User 1, User 2, etc.) for each of the people
in the class.

2. Make sure that none of the User files there is locked. The easiest way to
check this is to go to the View menu and choose the By Name command..
If any of the files has the picture of a little lock on the far right side of the win-
dow, that file is locked. To unlock the file, highlight its name. Go to the File
menu, and choose the Get Info command. In the lower left corner of the
box, click in the Locked checkbox, making the X which appears there disap-
pear.

3. If the file is not locked, it is difficult to determine which of the User files is re-
lated to the person having login difficulties. The best solution would be to
have the DIWE administrator deactivate the user's name and have the user
login to the system again, using a slightly different name.

At login, all users get the messages
"A file you need to use is busy. Would you like to try again?"
"Could not start application because you do not have the necessary

access privileges."

First, check sharing privileges for the DIWE folder (containing the application,
the instructor folder and other support files). Here's how:

1. Highlight the DI WE 1. 4 Net folder icon by clicking on it with your mouse.
2. Under the File menu, choose the Sharing... command.

3. A dialog box, titled with the name of your DIWE folder, will pop up. Check
the following options in the box:
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Be sure that there is an X in the checkbox under the file folder
icon, beside the words "Share this item and its contents."”

Make sure that there is an X beside the word EVERYONE in
each of the three options: See Folders, See Files, and Make
Changes.

Be sure that there is an X in the checkbox beside the words
"Make all currently enclosed folders like this one."

Next, check the network privileges for the DIWE Folder. The exact method
you'll follow will depend upon the network system you're using. See the "Setting
Network Permissions" in Chapter 5 for details on the required setting for your
network operating system.

All the instructors and classes have been entered and the appropriate files
show up in the DIWE 1.4 Net folder on the network fileserver; however,
when users login, only "The Staff* choice is available.

Check your workstations and server for additional copies of the DIWE 1.4 Net
folder. Your site should have only one copy of the DIWE 1.4 Net folder and that
copy should be on the network fileserver.

If you find additional copies, remove them and try launching DIWE again (In the
Finder, check the contents of any DIWE 1.4 Net folders you plan to delete to in-
sure that you do not accidentally erase the "real” copy of the file). When you re-
launch the program, you'll be asked to locate the Preferences file. Navigate to
the copy in the DIWE 1.4 Net file on your network file server. The instructors and
classes you've set up should appear.

Every time DIWE is launched, the program asks users to locate the
preferences file. The file has been located several times, but DIWE cannot
seem to keep track of the file's location.”

1. Make sure that the network fileserver mounted and that the network
permissions are correct. The preferences file should be located on the
network file server. Check the instructions in the "Setting Up Your Worksta-
tions" section of Chapter 4 for instructions on using the Chooser to mount the
fileserver. See the information on "Setting Network Permissions" in Chapter 5
to confirm that users have the correct access rights to the DIWE 1.4 Net
folder.

2. If the server is mounted and permissions are correct, throw away the
Config file on the local workstation and try the process again. The Config
file is located in the System folder on the hard drive of each workstation.
DIWE records the location of the network fileserver and the preferences file in
this Config File. By throwing the file away, you'll prompt DIWE to create a
new copy of the Config File. The program will ask you to locate the Prefer-
ences file one more time, but on subsequent logins, the program should re-
member the location of the Preferences file.

3. If your site is running At Ease security software, check the tips on trou-
bleshooting for At Ease earlier in this section.
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Users cannot login to DIWE can't log on to system. The only button not
grayed out is the Quit button.

Once users click an Instructor's name and a Class nhame, the Log In and New
User buttons will become active.

InterChange & Mail

Messages post very slowly to the InterChange sessions. Changes to the
Idle and Event Frequencies have no effect.

Check the local area network itself -- be sure that you have you are using the
fastest hardware you have access to and check your network settings. In par-
ticular, be sure that the server activity setting is high enough to allow for the
speedy movement of the many files in an InterChange session.

Closing an InterChange session using the Compact InterChange Transcript
command and selecting the "Close the session" checkbox fails to remove

the session from the list of conferences.

Check the network permissions for the files on your network fileserver, specifically
the DIWE 1.4 Net folder (See Chapter 5 for details on the permissions for your
network operating system). In addition, check Appleshare permissions and the
settings for the particular file to ensure that the "Can't be moved, renamed, or
deleted" checkbox is not marked.

A Mail message never appear in the list of Mail for a particular user.

Mail which is sent privately must be sent using the exact spelling of the user's
login name. For example, if a writer logs in as Patricia Jones, private mail mes-
sages have to be addressed to Patricia Jones ¥ Private mail messages sent to
Patty Jones won't get to her.

If private mail difficulties do not explain the messages, check whether the user is
logged into the correct class and whether the user is in the same Mail conference
in which the message was sent.

InterChange Messages scroll uncontrollably. The messages won't hold still

long enough to be read.

Move the scroll box away from the bottom of the scroll bar. Whenever the scroll
box is flush with the bottom of the scroll bar, new messages will read into the
upper Interchange window. If the scroll box is any place else, no more mes-
sages will show up and the Interchange session will not move at all.

New InterChange messages scroll never scroll into the transcript area.

Move the scroll box to the bottom of the scroll bar. Whenever the scroll box is
flush with the bottom of the scroll bar, new messages will read into the upper In-
terchange window. If the scroll box is any place else, no more messages will
show up and the Interchange session will not move at all.
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Messages are missing from the top of the transcript area during an
InterChange session. Messages at the end of the session are scrolling in
properly; only those at the beginning of the session are affected.

The transcript area in InterChange can only hold 32K characters. Some Inter-
Change sessions exceed that number, of course. Whenever the size of the In-
terChange transcript which is scrolling in exceeds 32K, the program drops mes-
sages from the beginning of the session from memory in order to make room for
the newer messages. All the messages are on the server and will be included in
the InterChange transcript. Note, however, that you'll need to open the transcript
using a word processor other than the Write word processor in DIWE (see the
next troubleshooting tip).

Messages are missing from IC transcript when it's opened in Write, the
program's word processor.

Write can only handle files up to 32K characters. Some InterChange sessions
exceed that number. If you scroll to the bottom of the Write window and discover
that the end of your transcript is missing, then your session ran longer than 32K.
If this happens, close the Write window, and open the transcript with another
commercial word processor. The transcript file is an ASCII Text file, which can be
opened with any word processor.

Instructors trying to create conferences or make a transcript get the
message:

"Could not complete your request because of a program error." or

"A file you need to use is busy. Would you like to try again?"

Check the network permissions for the DIWE 1.4 Net folder on your network file-
server. When an instructor creates conferences or makes a transcript, the pro-
gram needs to create, write, and delete files and directories on the server. If the
instructor does not have the correct network permissions, the program will display
these error messages. See Chapter 5 for details on "Setting Network Permis-
sions."

When compacting or creating an InterChange session, instructors get a
"disk error" message. Permissions are set correctly, and the same instructor
can can add files and folders to the directories using the Finder.

Check the performance enhancement to AFP in NetWare v4.x. To change the
setting:

1. Load AFPCON.NLM at the server console.

2. Select Detailed Configuration command from the menu.

3. Select Performance Enhancements from the menu.

4. Set Use AFP Estimated Offspring Count: to "NO."
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Periodically, a machine will not receive all the messages in the InterChange
session. The writer sees blank space instead.

In DIWE 1.3.6, sites using an NT server needed a special version of the program
to ensure that all the messages were received by all the machines. Because of
some differences in file-handling, NT fileservers were not accessing files in the
same way as sites using AppleShare. To correct the situation, these sites
needed a special NT version of DIWEr 1.3.6.

The corrections in this special NT version are included in DIWE 1.4. This situation
should not appear once a site upgrades to the latest version of the software.

Invent, Respond, & PromptManager

An instructor has written a new series of questions for Invent or Respond

using PromptManager, but the questions are not showing up when writers

select the tools in the program.
The new series needs to appear in the Question Series folder in the DIWE 1.4
Net folder on the network fileserver to show up in the program. To give teachers
more freedom, PromptManager was designed so that a teacher should work at
any Macintosh machine % in the classroom, in the office, or at home. Because
the program can be used in so many places however, it cannot save new series
to the correct place on the server for teachers. Instead, the file has to be copied
or moved into place using the Finder. If the Instructor cannot copy the file to the

Question Series folder, check the network permissions to ensure that teachers
have the access rights which they need (see Chapter 5).

DIWE does not default to the Question Series folder when writers choose
the Invent or Respond command from the Activity menu or the
Launcher.
A setting in Macintosh System 7.5 and higher setting for the workstations is in-
compatible with DIWE and needs changed to restore the defaults necessary for
DIWE. In the general control panel, there's a feature that tells the application (in

this case, DIWE) where to look for files by default. The default for System 7.5
conflicts with the instructions DIWE is using to look for the Question Series folder.

Make these changes to restore DIWE's defaults:

1. From the Apple Menu,. choose Control Panels.
2. From the list of Control Panels, choose General Controls.

3. In the Documents section (lower right corner), select the first radio button,
which says "Folder which contains the application." [Neither of the other two
options will work.]

Close the General Controls window.
Restart your Macintosh for the change to take effect.
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After you complete these steps, DIWE should be able to find the Question Series
folder by default. You'll need to set the General Controls on each of the machines
in your classroom.

Other Tools & Commands

When a user tries to use the Change Password command, the error
message "A file you need to use is busy. Would you like to try again?"

appears.
Check the network permissions for the DIWE 1.4 Net folder. DIWE needs to write
new information to the login records in order to change a user's password. Check

the "Setting Network Permissions" information in Chapter 5 for details on the cor-
rect permissions for your network operating system.

Write (the program's word processor) won't open a file.
Write can only handle files up to 32K characters. Check the size of the file which

the writer is trying to open. If the file is larger than 32K, close the Write window,
and open the file with another commercial word processor.
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Chapter

11

Getting Additional Help
with DIWE

If you have a question about using the software, whether a technical question or
a pedagogical question, you can choose among these resources:

1.

If you have Internet access, check the frequently asked questions and trou-
bleshooting information on the Daedalus Group WWW page, especially for
information written after the publication of this guide. The Daedalus Group
web page is available at http://ww. daedal us. con!

If you have e-mail access, consider asking on the TEACH e-mail discussion
list. The TEACH e-mail list links teachers in conversation about teaching,
problem-solving, and troubleshooting. To subscribe to TEACH, send an e-
mail message to | i st proc@laedal us. com

include the subject line: sub teach

include the single line message:
subscribe teach your-firsthname your-lastname
for example, subscribe teach Jerri Stephens

Once you've subscribed, send your questions, insights, and success stories
to t each@laedal us. com

If you have e-mail access, but no WWW _access, you can access Daedalus
HelpSheets which duplicate the information available from the WWW pages.
Send an e-mail message to hel psheet s@laedal us. comwith the subject
line INDEX to see a list of the troubleshooting sheets currently available.
Messages sent to this address automatically return Help Sheets with informa-
tion on using the Daedalus Integrated Writing Environment. The Help Sheet
you receive depends upon the subject line for your message.

If you have no Internet access, you can fax 1-512-452-5206 for details on
obtaining the latest troubleshooting information by fax or postal mail.
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Sending a Request

If you have questions about DIWE which you can't find an answer to, contact
Daedalus Customer Services.

Before you contact a Customer Services Representative, gather the basic details
on your machines, as noted on the Customer Support Request Form on the next
page. By providing this information, you will include the details necessary to an-
swer any questions you may have quickly. In addition to this information, the file
includes questions about your site and the situation you've encountered.

Once you have gathered the information on your machines, you can
fax it to 1-800-388-8152,
send it in an e-mail message to hel p@aedal us. com

call the Daedalus Group at 1-800-879-2144.
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DIWE 1.4 Customer Services Request Form

As you fill in the form, please be as specific as possible about your lab's set-up
and the details of the situation.

Name:

School:

Phone Number:
Fax Number
E-mail Address

What is the Brand, Model, & Clock Speed for your workstations?

What is the Brand, Model, & Clock Speed for your fileserver?

What is your Networking Hardware? (For example, Phone Net, Token Ring, Eth-
ernet , and so on)

What is your Network Operating System? (For example, AppleShare, Novell, NT,
Lantastic, and so on)

What other software is running on your machines while you use DIWE 1.4?
Please be sure to include information about any security programs you might be
running along with DIWE (such as At Ease, FoolProof, or MacControl).
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Description of Situation

1. Include a sense of the events leading up to any problem. In other words,
exactly where in the program do you have difficulty? What works? What
conditions seem to enable or disable the problem?

2. Indicate how universal the situation is. For instance, is the problem
showing up on all machines or only a few? (If so, are the machines differ-
ent in any way?) Is it occurring in only some classes or to some students?
Does it happen only at certain times of day?

3. Specify how often the problem occurs — does it happen all the time?
sporadically? Does there seem to be any pattern?

4. Record any error messages you see exactly as they appear on screen.
Indicate what you were doing just before the error as well.
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